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Module Introduction

This module will explain the data access procedures used to retrieve and
view data stored in the geodatabase. We will also cover the steps
necessary for indexing layers stored in the eCoastal system, and
demonstrate some of the tools available in the custom toolbars. * ArcMap

* eGlIS: Data Viewer Toolbar

ArcGIS Components

Skills Learned

* Understanding the purpose of the GIS Management Database
* Index a new layer in the geodatabase

« Ability to locate and retrieve data from the geodatabase using the
project name, category or keyword.

@. Coastal Applications Using ArcGIS
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Lecture: eCoastal Applications

The eCoastal’'s eGIS Toolbox was created as a comprehensive set of
applications that enable stakeholders in management decisions to explore
the broad spatial and temporal impacts of potential management

actions. In the U.S. Army Corps of Engineers (USACE), these tools have
emerged as necessary components for effective planning and prediction of
regional and local coastal processes. A geographic information system
with specialized applications was developed to provide baseline information
for regions including hydrographic and topographic data, shoreline position,
aerial and oblique photography, hyperspectal imagery, dredging records,
nautical charts, and other data regarding regional utilities, infrastructure,
and land use.

In this module we will discuss the Data Viewer Tools and Imagery Manager
toolbars.

eGIS: Data Yiewer Tools 1

Sutfare * ﬁK * ‘Q; Maps * Laver * Locate ™ Data ™ @ C}x

eGIs: Dreddq... 5
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Exercise A: Loading the eGIS Data Viewer Tools

eGIS Toolbox has been created to assist GIS users in data
analysis and access to the geodatabase through the ArcGIS
ArcMap interface.

Tools have been grouped by common categories and stored
on a series of toolbars: Data Viewer, Survey, Report,
Dredge, Imagery Manager, and the SBAS-A Toolbar.

1. Open the eCoastal_Basemap.mxd file from the
C:\Training directory.

2. To turn on all eGIS toolbars:

[ From the Tools menu in ArcMap, select
‘Customize’.

] Check the desired toolbar.

Select the Data Viewer, Imagery Manager,
SBAS-A, and Survey Tools toolbars.

O Click Close. This will make the selected
toolbar visible.

Customize

Toalbars l Commands ] Optionz ]

T oolbars:

Taools

[ Topolagy

[ Tracking Analwst

[ Utiliby Metwark, Snalyst

[ &G15; Autok aps

[] &G15: Beach Fill Dresign Toals
eG15: Data Viewer Tools

[ &G15: Dredge Toals

&Gl5: Imagery Manager

[ &G15: Report Tools
ehl5: SBAS-A Toolbar
ell5: Survey Toals

Bezet...

Fevboard... Add from file... | | Cloze |

@ @ END OF EXERCISE A
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Exercise B: Indexing a New Layer
Background

In order for layers to appear in the Data Picker tool, the
layer must first be created and indexed into the GIS
Management Database. Once the layer is indexed, all
users of the system can access the data.

Goal

After this exercise you will be able to index layer files for
feature classes stored in the geodatabase.

Objectives

1. Access the geodatabase

2. Use the GIS Management Database to index the
layer file

3. Use the Data Picker Tool

Coastal Applications Using ArcGIS
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Exercise B: Indexing a New Layer

The GIS Management Database was created as a repository for indexing non-spatial data, such as reports, photos,
spreadsheets, as well as managing all layers stored in the geodatabase. The contents of the GIS Management Database
fuel the desktop and web applications. The main function of this database is to index and categorize each layer stored in

the geodatabase.

The GIS Management Database exists in 2 formats — Microsoft Access and SQL Server. Two versions were created to
allow this system to be transferable to those districts who do not have access to SQL server.

Here, the App_Project_Code table in the GIS Management Database populates the Available Projects list in the Data

Picker Application.

B App_Project_Codes : Tabla

ODEEENNEENENEEEEE

& Add Data =] 5X]
Select by Project ] S eleel by Calagoiy | Selack by Kepmand ] Bkl Laps
hwvalable Progect
Arwial Mavgahen Gl ;I Add Al Duala by Projace
QAW Navigabon BIS ~ ) = i
(| ) |Abigato: Habor Sy Bod Bazemap Data by Progect |
Arnlston Envmanmental 4
hpalachicola e
.'u '|:| !

- fydd Seimched Laye

Layer Desctipton

Cloge
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Exercise B: Indexing a New Layer

The GIS Management Database is used to manage projects contained within the enterprise GIS. This database contains
forms to manage project codes and all layers created for the eCoastal system. The online interface allows users, outside
of a GIS environment, to quickly query and view the details of the data and projects.

This data is accessed by the Power Users of your GIS system. Users with authorized access can add, edit, or delete GIS
projects or references to data layers. Contents of this database are used to fuel some of the web and desktop

applications of eCoastal.

2l eGIS Management - Manage Projects - Microsoft Internet Explorer 4 Handwriting &/ DrawingPad B 7

| Fle Edt View Favorites Tools Help
F Qe - © ﬂ |§| D ) Search d Favorites ) Al

 address | &) hitp://155.82. 164 40/egis/datamanagement/ManageProjectCodes aspx

¢ Googlew v @Searchweb - 2 B 15 blocked

eGIS Management Database

US Army Corp
of Engineers.
i Main

iii eGIS Waorking Dirctories

Project Codes Form

Search Project Codes...

ructcode 5ok v v i
Project Description | New Project

Project Type Select Value -
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Indexing a New Layer - Instructor Demonstration

Notes:

@ @ END OF EXERCISE B Coastal Applications Using ArcGIS
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Exercise C: Using the Data Picker Tools

Background

All data that has been indexed in the GIS Management
Database can be easily accessed using the Data Picker
tools available on the eGIS: Data Viewer Toolbar. This
GUI interface allows all users the ability to quickly search
available layers and directly add items to the Table of
Contents in ArcMap.

This custom interface allows the novice user, without prior
knowledge of the Spatial Data Standards, to browse the
geodatabase with little introduction to the system
architecture.

Goal

After this exercise you will be able to connect and
browse the contents of the geodatabase using the Data
Picker tool.

Objectives

1. Access the eGIS: Data Viewer Toolbar
2. Browse data stored in the database
3. Add data into the map display of ArcMap

Coastal Applications Using ArcGIS
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Exercise C: Using the Data Picker Tools

The Data Picker form allows you to search for geospatial data currently
available in the database. To load data from the geodatabase using the
Data Picker tool, use the following steps:

1. Click the Data Picker Toal, * from the Data Viewer Tools. This = Add Data
will open the following Add Data dialog:

Select by Project T Select by Categom T Select by Feyword T Edit Layers

Awailable Projects:

|anstal GIS Bazemap j Add All D ata by Project |

2. The Add Data dialog allows you to search for data by Project,
Category or Keyword.

Select a Category:

Add Basemap Data by Project |

Landform A
Tranzportation

3. To search by one of these topics, select the respective tab. A AR

Improvement M achinemny »

) . Auvailable Layers:

4. TO SearCh for da.ta by Avallable PrOJeCtS, from the ‘SeleCt by FI|E-r and Eit.z:.arn;s;_ll,lr ¢~ Add Selected Layer

Project’ tab, and select the desired project from the Available Shorcing Compios

Projects list. Upon selection, this will populate the Category list. ot

Erliasomany
1=rancal arelne LT

Layer Diescription

Rivers and Streams

[IFor this example, select the “Coastal GIS Basemap” project
and the “Hydrography” category.

Close

Available layers appear once a Category is selected. A short

description for the layer will be displayed in the ‘Layer Description’
once a layer name is clicked.

@ Coastal Applications Using ArcGIS
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Exercise C: Using the Data Picker Tools

5. Click the “Add Selected Layer” button to add the desired layer

into the Table of Contents.

[] For this example, select the “Wetlands.lyr”

Did You Know?

Instead of individually
adding in layers to the
table of contents,
once a Project is
selected you can
either “Add all Data by

Layer files are a reference to a data source such as a coverage,
geodatabase feature class, raster, and so on that defines how the
data should be displayed on a map. Layers can also define
additional properties, such as which features from the data source
are included. Layers can be stored in map documents (.mxd) or
saved individually as layer files (.lyr). Layers are conceptually
similar to themes at ArcView 3.x.

For eCoastal, layer files (.lyr) have been created and saved into
the standard directory structure for all geospatial datasets
available in the geodatabase. These layer files are then indexed
using the GIS Management Database. Once indexed, the layers
files are available in the Data Picker tool.

Project” or “Add

Basemap by Project”.

= Add Data

Select by Project T Select by Categom T Select by Feyword T Edit Layers

Awailable Projects:

|anstal GIS Bazemap j Add All D ata by Project ‘
Select a Categary: Add Basemap Data by Project |
Landform A

Tranzportation
Irnprovement D redain

Improvement M achinemny »

Auvailable Layers:

Rivers and Streanns. lyr I ¢~ Add Selected Layer "

Critical Shorelines. lyr
Shoreline Comples. lvr
Shoreline. lyr

Layer Diescription

Rivers and Streams

“whatlands. lyr
GOT 'Water Segments. lur
Histaorical Shoreline 1849 Iy [V

Close

Coastal Applications Using ArcGIS
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Exercise C: Using the Data Picker Tools

6. In some cases, you may not know the Project Name or the Category
for your desired dataset. If this is the case, you can locate data by
clicking the “Select by Keyword” tab.

. Type in the desired keyword in the search textbox.

[] For this example, type in the keyword “shoreline”.

. Click the “Search for Layers” button to query the database.

. The query will search the Project Name, Category, Layer Name,
Description and Keywords fields from the database. The results
appear below. Use the scroll bars to locate the desired dataset.

[] Locate the Shoreline.lyr from the Coastal GIS Basemap Project,
and click to select.

10.Click the “Add Selected Layer” button to add the layer into the
Table of Contents.

m Add Data

Enter Search Feyward:

e |sh0reline

Search Results:

Select by Project T Select by Cateqory T Select by Kepword Edit Layers

Search for Layers @

Coastal GI5 Basemap

Hudrography

Shoreline, lur

Project Categony | Layer | Description

Bazeline 2002 Hydrography Bazeline 2002 ...  The mean-high water
Bazeline 2002 Hydrography Bazeline 2002 ... The meat-high water
Bazeline 2002 Hydrography Baseline 2002 ... The mean-high water
Bazeline 2002 Hydrography gBaseline 2002 ... The mean-high water
Bazeline 2002 Hydrography Bageline 2002 ...  The mean-high water
Bazeline 2002 Hydrography Bazeline 2002 ...  Baszeline 2002 Shareli
Coastal GIS Basemap  Hydroaraphy Critical Shorelin..  Critical Shorelines
Coastal GIS Bazemap  Hydrograph Shoreline Comp...  Shareline Complex

Shoreline

Add Selected Layer ‘ @

Cloze

Coastal Applications Using ArcGIS
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Exercise C: Using the Data Picker Tools

Authorized users have the option to edit layer descriptions and
keywords. These changes allow the Power User to make
modifications to the indexed layers to make it easier to locate data in
the future. To modify existing settings, use the following steps:

11.Enter in the Power User password and click the “Enter” button.

L] Enter in “editpriv” as the password.
12.Select “Coastal GIS Basemap” as the Project Name.

13.Select “Disposal Area.lyr” as the Layer. Upon selection, this will filter
the form to show the details for this layer.

14.You have the option to add, edit or delete values in the Keywords
and Layer Description Field.

[1 Add your last name as one of the Keywords.

15.Click the “Save Changes” button.

To see the results and benefits of your modification, go to the “Select
by Keyword” tab and type in your last name as the search criteria.
Does the Disposal Area.lyr appear in the search results?

5-15

w| Add Data

Select by Project T Select by Category T Select by Keyword T Edit Layers
User Y erification
Pleaze enter a passward | Enter
Cloze:

= Add Data E'E'@

Select by Project T Select by Category T Select by Kewward T Edit Layers

Search

Feywords |GIW, Flarida @

Layer File |Disposal Arealyr

Layer Path |serverP ath_NOODALayer
Category |Landform

Layer Description Disposal Area

Save Changes @
First Prev | Mext Last
Cloze

S A il
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Exercise C: Using the Data Picker Tools

Individual Exercise

1. Using the Data Picker toolbar, create a map for the Mobile, AL that includes the following types of layers:

Counties, Zip Codes, Shoreline, Places of Interest, Sediment Transport Rates, Water and a NOAA chatrt.

2. Save the ArcMap project file as MyMapl.mxd into the C:\Training directory.

@ Coastal Applications Using ArcGIS
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Exercise C: Using the Data Picker Tools

Exercise Summary

This exercise introduced you to the user interface created for ArcMap that allows you to browse the geodatabase
without having a prior knowledge of Spatial Data Standards. You can search for data by project name, category, or

keyword. To assist in locating layers of information more quickly, authorized users have the option to edit layer
description or keywords.

@ @ END OF EXERCISE C
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Exercise D: Using the Tools of the Data Viewer Toolbar

Background Goal
The eGIS Data Viewer Toolbar was created to give the After this exercise you will be familiar with the tools
user quick tools for working with spatial data. For this available on the eGIS: Data Viewer Toolbar
exercise you will launch and use a number of tools on the
toolbar.

Objectives

1. Access the eGIS: Data Viewer Toolbar
2. Make a Quick Map
3. Browse to available Data Viewer Tools.

@ Coastal Applications Using ArcGIS
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Exercise D: Using the Tools of the Data Viewer Toolbar

1. Make a quick layout of the map display. From the Data Viewer eGl3: Data Viewer Tools
Toolbar, select Maps > Create Map. G" ® % Maps~  Layer v Locate ¥ Data ~

B uick Map-Report

2. Enter eCoastal Training as the Project Name.

3. Select a Portrait Map Orientation. This tool will automatically

build a map that is printer-ready. Zae0I5 Manpe X
Project Mame:
|eCoastal Training 9
4. Click the Make Map button when finished. Notice that a Layout rub-Tit'er
. . . Clazs Demo
has automatically been generated. At this point you can change A
any of the layout elements prior to sending the layout to the [
prlnter |E0mment 2
5. Change the Map Orientation size to Landscape. Notice the r:;‘z;lmmmoa =
maps automatically reformats and resizes the layout controls. E——
-
6. Click Exit. %
Map Orientation Map Units
eﬁ‘ Portrait ¢ English
" Landzcap etric
b ap Units: Distance Units:
[Dec Degrees Jviles |
a Make Map | E sit |

@, Coastal Applications Using ArcGIS
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Exercise D: Using the Tools of the Data Viewer Toolbar

10.

11.

12.

13.

14.

15.

A tool was created to automatically import and plot points currently
stored in an MS Excel Spreadsheet. From the Data menu of the
Data Viewer Tools, select ‘Import Excel as Point’.

Click the Open Workbook button and browse to
C:\Training\Import_Excel.xIs.

Select the sheet name ‘Sample’ in for the Table option.
Select POINT_X as the X Item attribute.
Select POINT_Y as the Y Item attribute.

You can select any additional attributes to add to your new feature
class. Select Project Manager and click the Create Points button.

When prompted, select ‘Yes’ to set the spatial reference for this layer.

Select Geographic Coordinate System - World > WGS 84.

Browse to C:\Training and name the new point feature class
‘MyPoints’.

A new feature class will be created that represents points locations
stored in the Excel spreadsheet. Right-click on the new layer and
select ‘Zoom to Layer’ to see the contents of your new layer.

eGIs: Data Viewer Tools
& @ G | Maps v

Layer » Locate v Data »

@ "%

& Add XY 7
% [rnport Excel As Point

& Attrbutes To TextFile
‘& Make PointZ Shape

i Excel To Points

Open YWWorkboak, @

Table
|sample a j
X Item
POINT % |
Y Item

|POINT_Y @ |

Select Item[z] To Include As
Attribute ¥Yalues

Id

Project Mananger

Create Foints

FEX

nding Polygon

gon Area

S =
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Exercise D: Using the Tools of the Data Viewer Toolbar

16. Take a couple of minutes and test out the remaining tools of the Data Viewer Toolbar. In the next module we will

discuss the Data Picker tool. T

B L _d . ¢ 0ols

. . . \K <> - - - - <>

Available Functions of eGIS: Data Viewer Tools G ® K| vaps 0 Locate bata ® *

1. Database Connections allaps' Laver ¥ Locg Qn:n:ate * [Data -

2. Data Picker I @ Creake Map :,3 Find %% Location

3. Zoom to Layer Ifij Cick Map-Repart Find by Aktribuke

4. Maps: Options allows users to quickly produce
printable products through a GUI interface. Layer ¥ Locate ¥  Data ¥ Data * | (&) < I

5. Layer: Basic Table of Content functions & sort Layers <y, add

6. Locate: Functions that allow users to find an XY location or 2 Move Layer(s)To Top B Import Excel As Point
feature attribute. . . T Move Layer(s) Ta Bottom B Attributes To TextFile

7. Data: A number of functlons_ are Iocated_ in the data menu. "L Make PointZ Shape
Here, users can add XY attributes to point feature classes, plot . _
XY coordinates stored in Excel spreadsheets, Export feature £ Bounding Polygon
attributes to a text file, Create a 3D enabled “PointZ” shape, i Polygon Area
Generate a bounding polygon, Calculate the area of a polygon or

covert drawn features to a shapefile.
8. Get XY Coordinate
9. Draw Azimuth
10. Delete onscreen Graphics

S =
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Exercise D: Using the Tools of the Data Viewer Toolbar

Exercise Summary

This exercise introduced you to some of the tools available on the eGIS: Data Viewer Toolbar. These tools provide
user-friendly interfaces to standard GIS tasks, such as Add Data, Import Excel Spreadsheets, or Building a Map Layout.
Users with minimal GIS training can quickly access and use data stored in the eCoastal geodatabase.

@ @ END OF EXERCISE D Coastal Applications Using ArcGIS
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Exercise E: Creating a Raster Index

Background

In some cases, managing a number of raster images
within ArcGIS can be cumbersome and time consuming.
The Imagery Manager toolbar was created to assist to the
management of multiple raster images.

Goal

After this exercise you will be able to create a raster
index from layers loaded in the table of contents or
generated directly from world files.

Objectives

1. Access the eGIS: Imagery Manager Toolbar

2. Create an index from data loaded into the TOC
3. Create an index directly from World Files

4. Load images using the newly created index

Coastal Applications Using ArcGIS
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Exercise E: Creating a Raster Index

1.

Open the Raster_Index.mxd in C:\Training. Raster images have be already
added into the Table of Contents. We will use the index tool to create an
index of these layers.

Click on the ‘Build Raster Index’ tool from the Imagery Manager toolbar.

Ensure that the ‘Raster Images Currently in the Table of Contents’ is
selected.

Click on the ‘Save As’ button and name the new shapefile myindex1.shp.
Click Save.

Click on the Create Index button. This will create a point shapefile and load
the layer automatically into the Table of Contents.

To turn on raster images using the index, first set the Index Properties. Click
the Property button on the Imagery Manager toolbar.

Select myIndex1 as the Index Layer and select LayerName for both the
File Path and File Name. Click the Set Properties button.

Using ArcMap’s selection tool, select a point or group of points in the raster
index.

eGIS: Imagery Ma... [X]
2 I

. Build Raster Index

| want to build a raster index ..

f* From Raster Images Currently in the Table of Contents

" From YWarld Files Stored in this Directony:

Save Index Shapefile bz

|
_ Bowse |
| H

|E: WTrainingsmylndes1.shp

Create |ndex

= Set Imagery Index Proper... E@

Select Index Layer:

|m_l,l|nu:|e:-:‘| j
Select File Path Attribute:

|La_l.JerN ame ﬂ
Select File Mame Attribute: a

*If building index only from items in T able of Contents,

zelect the the filename attribute for both attibute selection
boxes above,

Set Properties ‘

S =
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Exercise E: Creating a Raster Index

9. Click on the Load Images menu and select ‘Turn Layers on by TOC
Index’. This will turn on and move the selected raster images to the top of
the table of contents.

eGIS: Imagery ! .. [x]
[+ B Load Images ~

10. In some cases you may have far too many images to first load them in the
table of contents. This tool also allows you to directly build an index from
world files contained with your raster image.

[1 Remove all layers in the Table of Contents.

| Build Raster Index

1 To build an index from world files, click the ‘Build Raster Index’ button.

| wwant to build a razter indes ..

" From Razter Images Currently in the Table of Contentz

11. Select the ‘From World Files Stored in this Directory:’ option. & FromWorld Files Stored in this Directory

[ Click the Browse button and browse to the C:\Training directory. Click [CATrsiring

OK. Browse
Select Twpe : [hiw -

[ISelect the type of world file used. For this sample, select ‘tifw’. Check hers b Add points
Save Index Text As: b existing Text File

12. Click the ‘Save As’ button and save the index as myIndex2.txt in the B T

C:\Training directory. Create Index @

13. Click the ‘Create Index’ button. Once this button is selected, this tool mines
the world files stored in the directory you specified. The coordinates are
extracted and an index file is generated.

w - Coastal Applications Using ArcGIS
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Exercise E: Creating a Raster Index

14. To load images indexed by this layer, click the Index Properties tool. eGIS14nagery Ma... [X]
[+ B Load Images ~

15. Select mylndex2 as the Index Layer.

16. Select FilePath as the File Path Attribute.

= Set Imagery Index Proper... E]@

Select Index Layer:@
|m_l,l|n|:|e:-:2 ﬂ

Select File Path Attribute:

FilePath @ B
Select File Marne Attribute:
Fileh arne @ B
*If building indes anly from items in Table of Contents,
20. From the Load Images menu of the Imagery Manager toolbar, select Load E‘;'f;; thEDLhE? siewie sltilbuie fou el s iz weleellon
by File Path/File Name. Images will be pulled from the designated directory Set Propetties |
and loaded into the table of contents.

17. Select FileName as the File Name Attribute.

18. Click the Set Properties button.

19. Using ArcMap’s selection tool, select a point or group of points in the raster
index.

@, Coastal Applications Using ArcGIS
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Exercise E: Creating a Raster Index

Exercise Summary

Managing a large number of raster images in ArcGIS can be a difficult task. Using tools provided in the eGIS: Imagery
Manager toolbar you can quickly build an index of the raster images. Additional tools are provided to allow you to load
and view the desired images.

@ @ END OF EXERCISE E Coastal Applications Using ArcGIS
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